Ericsson MD-110 Serial PIMG Integration Guide
for Cisco Unity 4.0

Revised October 12, 2007

This document provides instructions for integrating the Ericsson MD-110 phone system with
Cisco Unity by using the Intel NetStructure PBX-IP Media Gateway (PIMG) and an RS-232 serial cable.

Integration Tasks

Before doing the following tasks to integrate Cisco Unity with the Ericsson MD-110 phone system by
using the Intel NetStructure PBX-IP Media Gateway (PIMG), confirm that the Cisco Unity server is
ready for the integration by completing the applicable tasks in the applicable Cisco Unity installation
guide.

The following task lists describe the process for creating the integration.

Task List to Create the Integration

st
CISCO.

Use the following task list to set up a new integration with the Ericsson MD-110 phone system. If you
are installing a new Cisco Unity server by using the applicable Cisco Unity installation guide, you may
have already completed some of the following tasks.

1. Review the system and equipment requirements to confirm that all phone system and Cisco Unity
server requirements have been met. See the “Requirements” section on page 2.

2. Plan how the voice messaging ports will be used by Cisco Unity. See the “Planning How the Voice
Messaging Ports Will Be Used by Cisco Unity” section on page 5.

3. Program the Ericsson MD-110 phone system and extensions. See the “Programming the Ericsson
MD-110 Phone System” section on page 7.

4. Set up the PIMG units. See the “Setting Up the PIMG Units” section on page 9.

5. Create the integration. See the “Creating a New Integration with the Ericsson MD-110 Phone
System” section on page 17.
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Caution Do not edit the phone configuration file (also known as the switch ini file) to customize this

integration. If you change the settings in this file, the integration may not function correctly.

Test the integration. See the “Testing the Integration” section on page 21.

(Cisco Unity 4.1 and later) If you have a secondary server for Cisco Unity failover, integrate the
secondary server. See the “Integrating a Secondary Server for Cisco Unity Failover” section on
page 25.

Requirements

The Ericsson MD-110 integration supports configurations of the following components:

Phone System

Ericsson MD-110.
Software level BC6 or later.
ICU card installed to provide the serial data port.

One or more of the applicable PIMG units. For details, refer to the “Supported Circuit-Switched
Phone System Integrations” section in the applicable Supported Hardware and Software, and
Support Policies at
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html.

The serial data port on the phone system connected to the serial port on the master PIMG unit with
an RS-232 serial cable.

We recommend that the serial cable have the following construction:
— A maximum of 50 feet (15.24 m) in length
— 24 AWG stranded conductors
- Low capacitance—for example, no more than 12 pF/ft (39.4 pF/m) between conductors
— At least 65 percent braided shield over aluminized polymer sleeve around conductors
— UL-recognized overall cable jacket insulation with low dielectric constant
— Braided shield fully terminated to and enclosed by a metal connector backshell
— Gold-plated connector contacts

The voice messaging ports in the phone system connected by analog lines to the ports on the PIMG
units.

We recommend that you connect the voice messaging ports on the phone system to the ports on the
PIMG units in a planned manner to simplify troubleshooting. For example, the first phone system
voice messaging port connects to the first port on the first PIMG unit, the second phone system voice
messaging port connects to the second port on the first PIMG unit, and so on.

The PIMG units connected to the same LAN or WAN that Cisco Unity is connected to.
If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

— For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice
messaging port.

Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0
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Caution  If you use G.729a codec formatting over a WAN and your PIMG units use firmware release 4
SU6 or earlier, you must disable comfort noise. Otherwise, callers will hear loud comfort
noise at certain points. For details, see the “Appendix: PIMG Integrations Over a WAN That
Use the G.729a Codec May Need to Disable Comfort Noise” section on page 28.

— For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice
messaging port.

— No network devices that implement network address translation (NAT).
— A maximum 200 ms network latency.

e The phone system ready for the integration, as described in the documentation for the phone system.

Cisco Unity Server

e Cisco Unity installed and ready for the integration, as described in the applicable Cisco Unity
installation guide at
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html.

¢ A license that enables the applicable number of voice messaging ports.

Integration Description

The Ericsson MD-110 PIMG integration sends call information and MWI requests through the data link,
which is an RS-232 serial cable that connects the phone system and the master PIMG unit. Voice
connections are sent through the analog lines between the phone system and the PIMG units. The PIMG
units communicate with the Cisco Unity server through the LAN or WAN by using Session Initiation
Protocol (SIP). Figure 1 shows the required connections.

Figure 1 Connections Between the Phone System and Cisco Unity
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Call Information

The phone system sends the following information through the data link:

The extension of the called party

The extension of the calling party (for internal calls) or the phone number of the calling party (if it
is an external call and the system uses caller ID)

The reason for the forward (the extension is busy, does not answer, or is set to forward all calls)

Cisco Unity uses this information to answer the call appropriately. For example, a call forwarded to
Cisco Unity is answered with the personal greeting of the subscriber. If the phone system routes the call
to Cisco Unity without this information, Cisco Unity answers with the opening greeting.

Note  The Ericsson MD-110 phone system also sends requests to turn on and turn off MWIs through the data
link.

Integration Functionality

The Ericsson MD-110 integration with Cisco Unity provides the following integration features:

Call forward to personal greeting
Call forward to busy greeting
Caller ID

Easy message access (a subscriber can retrieve messages without entering an ID because
Cisco Unity identifies the subscriber based on the extension from which the call originated; a
password may be required)

Identified subscriber messaging (Cisco Unity identifies the subscriber who leaves a message during
a forwarded internal call, based on the extension from which the call originated)

Message waiting indication (MWI)

Integrations with Multiple Phone Systems

Depending on the version, Cisco Unity can be integrated with two or more phone systems:

Cisco Unity 4.0 and 4.1 can be integrated with a maximum of two phone systems at one time. For
information on and instructions for integrating Cisco Unity with two phone systems, refer to the
Dual Phone System Integration Guide at
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_configuration_guide09186a00802
11b2e.html.

Cisco Unity 4.2 and later can be integrated with two or more phone systems at one time. For
information on the maximum supported combinations and instructions for integrating Cisco Unity
with multiple phone systems, refer to the Multiple Phone System Integration Guide at
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_configuration_guide09186a00806
192a3.html.
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Planning How the Voice Messaging Ports Will Be Used by

Cisco Unity

Before programming the phone system, you need to plan how the voice messaging ports will be used by
Cisco Unity. The following considerations will affect the programming for the phone system (for
example, setting up the hunt group or call forwarding for the voice messaging ports):

e The number of voice messaging ports installed.

e The number of voice messaging ports that will answer calls.

e The number of voice messaging ports that will only dial out, for example, to send message
notification, to set message waiting indicators (MWIs), to make AMIS deliveries, and to make
telephone record and playback (TRAP) connections.

The following table describes the voice messaging port settings in Cisco Unity that can be set in UTIM,
and that are displayed as read-only text on the System > Ports page of the Cisco Unity Administrator.

Table 1 Settings for the Voice Messaging Ports

Field Considerations

Extension Enter the extension for the port as assigned on the phone system.

Enabled Check this check box to enable the port. The port is enabled during normal operation.

Uncheck this check box to disable the port. When the port is disabled, calls to the port get a
ringing tone but are not answered. Typically, the port is disabled only by the installer during
testing.

Answer Calls

Check this check box to designate the port for answering calls. These calls can be incoming
calls from unidentified callers or from subscribers.

Message Notification

Check this check box to designate the port for notifying subscribers of messages. Assign
Message Notification to the least busy ports.

Dialout MWI

(not used by serial or SMDI
integrations)

Check this check box to designate the port for turning MWIs on and off. Assign Dialout MWI
to the least busy ports.

AMIS Delivery

(available with the AMIS
licensed feature only)

Check this check box to designate the port for making outbound AMIS calls to deliver voice
messages from Cisco Unity subscribers to users on another voice messaging system.

Cisco Unity supports the Audio Messaging Interchange Specification (AMIS) protocol,
which provides an analog mechanism for transferring voice messages between different
voice messaging systems.

This setting affects outbound AMIS calls only. All ports are used for incoming AMIS calls.

Because the transmission of outgoing AMIS messages may tie up voice ports for long
periods of time, you may want to adjust the schedule on the Network > AMIS > Schedule
page so that outgoing AMIS calls are placed during closed hours or at times when

Cisco Unity is not processing many calls.

TRAP Connection

Check this check box so that subscribers can use the phone as a recording and playback
device in Cisco Unity web applications and e-mail clients. Assign TRAP Connection to the
least busy ports.

The Number of Voice Messaging Ports to Install

The number of voice messaging ports to install depends on numerous factors, including:
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e The number of calls Cisco Unity will answer when call traffic is at its peak.

e The expected length of each message that callers will record and that subscribers will listen to.
e The number of subscribers.

e The number of ports that will be set to dial out only.

e The number of calls made for message notification.

e The number of MWIs that will be activated when call traffic is at its peak.

e The number of AMIS delivery calls.

e The number of TRAP connections needed when call traffic is at its peak. (TRAP connections are
used by Cisco Unity web applications to play back and record over the phone.)

e The number of calls that will use the automated attendant and call handlers when call traffic is at its
peak.

It is best to install only the number of voice messaging ports that are needed so that system resources are
not allocated to unused ports.

The Number of Voice Messaging Ports That Will Answer Calls

The calls that the voice messaging ports answer can be incoming calls from unidentified callers or from
subscribers. Typically, the voice messaging ports that answer calls are the busiest.

You can set voice messaging ports to both answer calls and to dial out (for example, to send message
notifications). However, when the voice messaging ports perform more than one function and are very
active (for example, answering many calls), the other functions may be delayed until the voice messaging
port is free (for example, message notifications cannot be sent until there are fewer calls to answer). For
best performance, dedicate certain voice messaging ports for only answering incoming calls, and
dedicate other ports for only dialing out. Separating these port functions eliminates the possibility of a
collision, in which an incoming call arrives on a port at the same time that Cisco Unity takes the port
off-hook to dial out.

The Number of Voice Messaging Ports That Will Only Dial Out, and Not Answer Calls

Ports that will only dial out and will not answer calls can do one or more of the following:
¢ Notify subscribers by phone, pager, or e-mail of messages that have arrived.
e Turn MWIs on and off for subscriber extensions.

e Make outbound AMIS calls to deliver voice messages from Cisco Unity subscribers to users on
another voice messaging system. (This action is available only with the AMIS licensed feature.)

e Make a TRAP connection so that subscribers can use the phone as a recording and playback device
in Cisco Unity web applications.

Typically, these voice messaging ports are the least busy ports.

Caution

In programming the phone system, do not send calls to voice messaging ports in Cisco Unity that cannot
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging
port is set only to Dialout MWI, do not send calls to it.

Preparing for Programming the Phone System

Record your decisions about the voice messaging ports to guide you in programming the phone system.

Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0
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Programming the Ericsson MD-110 Phone System

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

If you use programming options other than those supplied in the following procedure, the performance
of the integration may be affected.

Do the following procedure.

To Program the Ericsson MD-110 Phone System

Check the software version on the phone system and the country variant that is configured. This
information may be useful for troubleshooting problems with the integration. For example:

<cadap;
CALENDAR DATA

==> Check the software version and Country variant

IDENTITY=ACM1
VERSION=CXP1010101/4/TSWSP02/R3A ==> 01 == Standard Application
Configure the analog extensions for the voice messaging ports similarly to the following example:

<excap:dir=1063&1064;
EXTENSION CATEGORY FIELDS

==> print analog extension

DIR TRAF SERV CDIV ROC TRM ADC BSEC
1063 00151515 0201120600 000151000 000001 0 010001701 O
1064 00151515 0201120600 000151000 000001 0 010001701 O

Configure the hunt group number for the voice messaging ports on the PIMG units similarly to the
following example:

<vmpop:grp=all;

VOICE MAIL GROUP DATA
GRP IFCIND

4500 1

==> print VM HuntGroup number

Associate the voice messaging port extensions with the hunt group number similarly to the following
example:

<vmpop:dir=all;
VOICE MAIL PORT DATA

==> print VM port DN associated with the HuntGroup number

DIR PORT IFCIND
1063 1063 1
1064 1064 1

Configure the voice mail function information similarly to the following:

<vmfup:ifcind=1;

VOICE MAIL FUNCTION DATA
IFCIND VMF POFMT

1 EXTN3 4

==> print VM function information

Define the I/O device interface for voice mail similarly to the following:

<ioddp; ==> print I/0 Device interface

I/0 DEVICE DATA

NODE IODEV/SUBFS BPOS/EQU I/0-BUS TYPE/USAGE STATUS AUTH
SYSN V-MAIL 001-0-60-3 - ouT IN SERVICE

Configure the I/O device function for voice mail similarly to the following example:

<iofdp; ==> print I/0 Device Function
I/0 FUNCTIONS DEFINITION
TIODEV TRD NDC CALLS WAIT DELAY SUPER

[ oL-12369-03

Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0 ]



Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0 |

B Programming the Ericsson MD-110 Phone System

V-MAIL BOTH 2 30 5 YES

Step8  Configure the serial connection parameters for voice mail similarly to the following example:

<ioifp; ==> print I/O Device serial interface parameters VM
I/0 INTERFACE CHARACTERISTICS

TIODEV IFACE BAUDR WORDL PARITY STPBIT PROC

SYSTERMINAL v24 ALL 8 NONE 1 ECHO

V-MAIL v24 9600 8 NONE 1 ECHO

Step9  Configure MWIs to be sent over the serial cable similarly to the following example:

<icmwp:sid=1; ==> print MWI ext using on serial interface
INFORMATION COMPUTER MESSAGE WAITING DATA

SID DTXT KFCN DIG

1 4500 MWC 4500

Step10  Configure the filler information similarly to the following example:

<ICFUP:ifcind=1; ==> print the filler information
INFORMATION COMPUTER COMMON FUNCTIONS DATA

MESSAGE WAITING FUNCTIONALITY IS ALL

INFORMATION COMPUTER EQUIPMENT DATA

IFCIND IODEV EQU RATE DFMT UPDFCN PARITY CCHECK
1 V-MAIL 4 YES
FILLER=48 ICEXG=NONE USER=NONE

Step11  Configure the hookflash timer similarly to the following example:

<aspap:parnum=253; ==> print Hookflash timer
APPLICATION SYSTEM PARAMETERS
PARNUM PARVAL

253 110

Step12 Configure the on-hook timer similarly to the following example:

<aspap:parnum=252; ==> print On-hook timer
APPLICATION SYSTEM PARAMETERS
PARNUM PARVAL

252 225

Step13 Program each phone to forward calls to the hunt group number (defined in Step 3), based on one of the
Cisco Unity call transfer types shown in Table 2.

Table 2 Call Transfer Types
Transfer Type Usage
Release transfer Program the phone to forward calls to the pilot number when:

(blind transfer) e The extension is busy

e The call is not answered

Supervised transfer Program the phone to forward calls to the pilot number only when the
call is not answered. Confirm that call forwarding is disabled when the
extension is busy.

Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0
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Setting Up the PIMG Units

Step 1

Step 2

Step 3
Step 4
Step 5
Step 6
Step 7

Step 8

Step 9
Step 10
Step 11

Step 1

Do the following procedures to set up the PIMG units that are connected to the Ericsson MD-110 phone
system.

These procedures require that the following tasks have already been completed:

e The phone system is connected to the PIMG units by using analog lines and the applicable RS-232
serial cable.

e The PIMG units are ready to be connected to the LAN or WAN.
e The PIMG units are connected to a power source.

Fields that are not mentioned in the following procedures must keep their default values. For the default
values of all fields, see the documentation for the PIMG unit.

To Download the PIMG Firmware Update Files for Analog PIMG Units

On a Windows workstation that will have access to the PIMG units, open a web browser and go to the
Cisco Unity PIMG Software Download page at
http://www.cisco.com/cgi-bin/tablebuild.pl/unity-PIMG.

~

Note  To access the software download page, you must be logged on to Cisco.com as a registered user.

On the Cisco Unity PIMG Software Download page, click the most recent version of the firmware for
analog PIMG units.

On the Details page, click Next.

On the Document page, click Accept.

In the Enter Network Password dialog box, enter your user name and password, then click OK.
In the File Download dialog box, click Save.

In the Save As dialog box, browse to the Windows workstation that will have access the PIMG units,
browse to a directory where you want to save the file, and click Save.

In the Download Complete dialog box, click Open. The window for extracting the PIMG firmware
update files appears.

Click Extract.
In the Extract dialog box, browse to the directory where you want the extracted files, and click Extract.

Close the window for the extracting application.

To Set Up the Analog PIMG Units

On the Windows workstation, add a temporary route to enable access to the PIMG units.
a. On the Windows Start menu, click Run.
b. Enter cmd, and press Enter. The Command Prompt window appears.

c. At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press
Enter.
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Step 2
Step 3
Step 4

Step 5
Step 6
Step 7
Step 8

Step 9
Step 10
Step 11

Step 12
Step 13
Step 14
Step 15
Step 16
Step 17
Step 18
Step 19
Step 20

For example, if the IP address of the workstation is 198.1.3.25, enter “route add
10.12.13.74<space>198.1.3.25” in the Command Prompt window.

d. Close the Command Prompt window.
Connect a PIMG unit to the network.
In the web browser, go to http://10.12.13.74.

On the System Login page, enter the following case-sensitive settings.

Table 3 System Login Page Settings
Field Setting

Username admin

Password IpodAdmin

Click Log On.

On the Configure menu, click Upgrade.
On the Upgrade page, click Browse.

In the Choose File dialog box, browse to the directory on the Windows workstation that has the extracted
PIMG firmware update files.

Click Ls_<xx>.app (where <xx> is multiple digits), and click Open.
On the Upgrade page, click Install.
After the file is installed, a message prompting you to restart the PIMG unit appears. Click Cancel.

A

Caution Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if
the file installation fails. Restarting the PIMG unit at this step may prevent the PIMG unit
from functioning correctly.

Repeat Step 6 through Step 11 for the file Run_<xx>.dsp.

On the Configure menu, click Upgrade.

On the Upgrade page, under Import, click Browse.

In the Choose File dialog box, browse to the file Ls_<xx>.fsh.

Click Ls_<xx>.fsh, and click Open.

On the Upgrade page, click Install.

After the file is installed, a message prompting you to restart the PIMG unit appears. Click OK.
In the web browser, go to http://10.12.13.74.

On the System Login page, enter the following case-sensitive settings.

Table 4 System Login Page Settings
Field Setting

Username admin

Password IpodAdmin

Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0
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Step 21
Step 22
Step 23

Step 24
Step 25
Step 26

Step 27
Step 28
Step 29

Click Log On.
On the Configure menu, click Password.

On the Password page, enter the following settings.

Setting Up the PIMG Units

Table 5 Password Page Settings
Field Setting
Old Password IpodAdmin

(This setting is case sensitive.)

New Password <your new password>

(This setting is case sensitive.)

Confirm Password <your new password>

(This setting is case sensitive.)

Click Change.
On the Configure menu, click System.

On the System page, enter the following settings.

Table 6 System Page Settings
Field Setting
Operating Mode SIpP

Telephony Switch Type |None

PCM Coding uLaw

Click Apply Changes.
On the Configure menu, click Serial Protocol.

On the Serial Protocol page, enter the following settings.

Table 7 Serial Protocol Page Settings
Field Setting
Serial Mode Click the applicable setting:

system integration.

system integration.

e Master—This PIMG unit is connected to the data link serial cable from
the phone system. There can be only one master PIMG unit in a phone

e Slave—This PIMG unit is not connected to the data link serial cable from
the phone system. There can be multiple slave PIMG units in a phone

Serial Interface MD110
Protocol
Cpid Len Click the applicable setting. Typically, the settings are 7 or 10.

Cpid Padding String  |Leave this field blank or enter the applicable string.
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Step 30
Step 31
Step 32
Step 33

Step 34
Step 35
Step 36

Table 7 Serial Protocol Page Settings (continued)
Field Setting

Voice Mail Port Len 2

System Number 1

MWI Response 2000

Timeout

IP Address of Serial
Server

If the PIMG unit is the master, leave this field blank.

If the PIMG unit is a slave, enter the IP address of the master PIMG unit (the
PIMG unit that is connected to the data link serial cable from the phone
system).

Serial Cpid Expiration

2000

Logical Extension
Number

Enter the extension number for each port on the PIMG unit.

Click Apply Changes.

On the Configure menu, click Gateway.

On the Gateway page, click the Gateway Routing tab.

On the Gateway Routing tab, enter the following settings.

Table 8 Gateway Routing Tab Settings

Field Setting

Fault Tolerance (Cisco Unity without failover) No

Enabled (Cisco Unity with failover configured) Yes

Load Balancing No

Enabled

VoIP Endpoint ID: (Cisco Unity without failover) <the IP address of the Cisco Unity server>

! (Cisco Unity with failover configured) <the name the primary Cisco Unity
server; this setting must match the Contact Line Name field setting in UTIM>

VoIP Endpoint ID: (Cisco Unity without failover) <blank>

2

(Cisco Unity with failover configured) <the name the secondary Cisco Unity
server; this setting must match the Contact Line Name field setting in UTIM>

Click Apply Changes.

Click the Gateway Advanced tab.

On the Gateway Advanced tab, enter the following settings.

Table 9 Gateway Advanced Tab Settings
Field Setting

Call Connect Mode OnAnswer

Destination for <blank>

Unroutable IP Calls

r Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0
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Table 9 Gateway Advanced Tab Settings (continued)
Field Setting
Destination for <blank>
Unroutable PBX Calls

Monitor Call No
Connections

Maximum Call Party 2000
Delay (msecs)

Dial Digit on Time 100
(msecs)

Dial Inter-Digit Time 100
(msecs)

Dial Pause Time 2000
(msecs)

Turn MWI On FAC <blank>
Turn MWI Off FAC <blank>
Outbound Call 10000
Connect Timeout

(msecs)

Wait for Yes
Ringback/Connect on

Blind Transfer

Hunt Group Extension

<the pilot number for the Cisco Unity voice messaging ports>

Audio Compression

Click the preferred codec for audio compression:
e G.711 Only
e G.729 A Preferred

RTP Digit Relay Mode |RFC2833

Signaling Digit Relay |Off

Mode

Voice Activity Off

Detection

Frame Size Click the applicable setting:

e G.711—20
e (G.729a—10

A

Caution  Failure to use the correct setting will result in recorded messages

containing nothing but silence.
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Table 9 Gateway Advanced Tab Settings (continued)
Field Setting
Frames Per Packet Click the applicable setting:

e G.711—1

e G.729a—2

A

Caution  Failure to use the correct setting will result in recorded messages
containing nothing but silence.

Call Control QOS (PIMG units connect only to a LAN) 0

Byte

~

(PIMG units connect to a WAN) 104

Note  For details on the setting for a LAN, see the caveat CSCsb96387.

RTP QOS Byte (PIMG units connect only to a LAN) 0

S

(PIMG units connect to a WAN) 184

Note  For details on the setting for a LAN, see the caveat CSCsb96387.

SNMP Traps Enabled |No

E-mail Alarms No
Enabled

Step 37 Click Apply Changes.
Step 38 Click the Gateway Capabilities tab.

Step39 Depending on how you have planned to use the voice messaging ports, click the applicable setting for
each port in the Telephony Port Capability column.

Table 10 Gateway Capabilities Tab Settings

Telephony Port Capability Settings  |Voice Messaging Port Usage

Calls-Only The port will answer incoming calls only and will not dial out

(for example, to send message notifications).

MWTIs-Only The port will dial out only (for example, to send message

notifications) and will not answer incoming calls.

Both The port will answer incoming calls and will also dial out (for

example, to send message notifications).

A

Caution  In setting up the PIMG unit, do not send calls to ports in Cisco Unity that cannot answer calls
(voice messaging ports that are not set to Answer Calls). For example, if a voice messaging
port is set only to Dialout MWI, do not send calls to it. Otherwise the integration will not

function correctly.

r Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0

0L-12369-03 |


http://www.cisco.com/cgi-bin/Support/Bugtool/onebug.pl?bugid=CSCsb96387
http://www.cisco.com/cgi-bin/Support/Bugtool/onebug.pl?bugid=CSCsb96387

| Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0

Setting Up the PIMG Units 1l

If a portin Cisco Unity is disabled, click No in the Telephony Port Enabled column for the corresponding
port on this tab. Note that changing a setting in the Telephony Port Enabled column requires restarting

the PIMG unit.
Step40 Click Apply Changes.

Step41  On the Configure menu, click SIP.

Step42 On the SIP page, enter the following settings.

Table 11 SIP Page Settings

Field

Setting

Host and Domain Name

<the domain name of the PIMG unit>

Server Port

5060

Primary Proxy Server Address

(Cisco Unity without failover) <the IP address of the Cisco Unity
server>

(Cisco Unity with failover configured) <the 1P address of the
primary Cisco Unity server>

Primary Proxy Server Port

5060

(When you configure more than one PIMG unit, increase this setting
by 1 for each successive unit. For example, unit 2 will be 5061,
unit 3 will be 5062, and so on. For failover, this setting must match
the setting for the Backup Proxy Server Port field.)

Backup Proxy Server Address

(Cisco Unity without failover) Not applicable; leave the default
setting.

(Cisco Unity with failover configured) <the 1P address of the
secondary Cisco Unity server>

Backup Proxy Server Port

(Cisco Unity without failover) Not applicable; leave the default
setting.

(Cisco Unity with failover configured) 5060

(When you configure more than one PIMG unit, increase this setting
by 1 for each successive unit. For example, unit 2 will be 5061,
unit 3 will be 5062, and so on. For failover, this setting must match
the setting for the Primary Proxy Server Port field.)

Proxy Query Interval 10
T1 Time 400
T2 Time 3000

Step43 Click Apply Changes.

Step44 On the Configure menu, click IP.

Step45 On the IP page, enter the following settings.
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Step 46
Step 47
Step 48

Step 49

Step 50

Step 51

Step 52

Step 53

Step 54

Table 12 IP Page Settings
Field Setting
Client IP Address <the new IP address you want to use for the PIMG unit>

(This is the IP address that you will enter in UTIM when you create the
integration.)

Client Subnet Mask <the new subnet mask, if the subnet mask is different from the default IP

address>
Default Network <the IP address of the default network gateway router that the PIMG units will
Gateway Address use>
BOOTP Enabled No

Click Apply Changes.
On the Configure menu, click Tones.

On the Tones page, click the Learn tab.

A

Caution  Destination addresses cannot be duplicated in the same session. Otherwise, the process for
learning tones will not succeed. If you do not have enough available phones to learn all the
tones at one time, you can run multiple sessions to learn tones individually by checking or
unchecking the applicable Acquire Tone check boxes.

On the Tones page, for the Dialtone event, confirm that the Acquire Tone check box is checked and leave
the Destination Address field blank.

On the Tones page, for the Busy Tone event, confirm that the Acquire Tone check box is checked and do
the following substeps to verify that the tone is correct.

a. From a available phone, call a second phone.

b. Answer the second phone when it rings, and leave both handsets off so that both phones are busy.
c¢. From a third phone, dial one of the busy phones.

d. Confirm that you hear a busy tone.

e. Hang up the third phone but leave the handsets for the other two phones off.

On the Tones page, in the Destination Address field for Busy Tone, enter the extension that you dialed
in Step 50c. from the third phone.

On the Tones page, for the Error/Reorder Tone event, confirm that the Acquire Tone check box is
checked and do the following substeps to verify that the tone is correct.

a. From an available phone, dial an extension that does not exist.
b. Confirm that you hear the reorder or error tone.
c¢. Hang up the phone.

On the Tones page, in the Destination Address field for Error/Reorder Tone, enter the extension that you
dialed in Step 52a.

On the Tones page, for the Ringback Tone event, confirm that the Acquire Tone check box is checked
and do the following substeps to verify that the tone is correct.

a. From an available phone, dial an extension that does exist
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Step 55

Step 56

Step 57
Step 58
Step 59
Step 60
Step 61
Step 62

Creating a New Integration with the Ericsson MD-110 Phone System I

b. Confirm that you hear the ringback tone.
c¢. Hang up the phone.

On the Tones page, in the Destination Address field for Ringback Tone, enter the extension that you
dialed in Step 54a.

Click Learn.

~

Note  When running learn tones, the PIMG unit will restart after learning the first tone. For details, see
the caveat CSCsh53791.

When the process is complete, check the check box for each newly learned tone and click Apply.
Hang up the phones that you used in Step 50.

On the Configure menu, click Restart.

On the Restart page, click Restart Unit Now.

When the PIMG unit has restarted, in the View menu, click Refresh.

Repeat Step 2 through Step 61 on all remaining PIMG units.

Creating a New Integration with the Ericsson MD-110 Phone
System

Step 1

Step 2
Step 3

Step 4
Step 5

Step 6
Step 7

After ensuring that the Ericsson MD-110 phone system and the Cisco Unity server are ready for the
integration, do the following procedures to set up the integration and to enter the port settings.

To Create an Integration

If UTIM is not already open, on the Windows Start menu of the Cisco Unity server, click Programs >
Cisco Unity > Manage Integrations. UTIM appears.

In the left pane of the UTIM window, click Cisco Unity Server.

On the Integration menu of the UTIM window, click New. The Telephony Integration Setup Wizard
appears.

On the Welcome page, click Circuit-switched via Intel PIMG and click Next.

On the Name the Phone System Integration page, accept the default name or enter the phone system
name to identify this integration, then click Next.

On the Enter PIMG Settings page, click Add.
In the Add PIMG dialog box, enter the following settings, then click OK.

Table 13 Settings for the Add PIMG Dialog Box

Field Setting

Display Name <accept the default name or enter another name to identify this PIMG unit>
IP Address <the IP address of this PIMG unit>
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Step 8

Step 9
Step 10
Step 11

Step 12

Table 13 Settings for the Add PIMG Dialog Box (continued)
Field Setting

SIP Port 5060

Phone Lines (Ports) |8

Connected

<if you want to use fewer than eight voice messaging ports, enter the number
of ports (or phone lines) that you want to use with this PIMG unit>

Repeat Step 6 and Step 7 for each remaining PIMG unit that you are connecting to the Cisco Unity

SErver.

You can press the following buttons to modify, delete, or verify the PIMG units that you are connecting
to the Cisco Unity server.

Table 14 Buttons on the Enter PIMG Settings Page

Button Action

Add Displays the Add PIMG dialog box to add another PIMG unit to the
integration.

Modify Displays the Modify PIMG dialog box so that you can modify the settings of
the selected PIMG unit.

Delete Deletes the selected PIMG unit from the integration.

Ping Servers

Confirms that the IP address is correct for all PIMG units.

Licensing

Displays a list of the licensed, used, and available voice messaging ports on the
Cisco Unity server.

On the Enter PIMG Settings page, click Next.
On the PIMG Integration with the PBX page, click Yes.

In the This PIMG Is the Serial Master field, click the name of the PIMG unit that is connected to the
serial cable from the phone system, then click Next.

On the Configure Cisco Unity SIP Settings page, enter the following settings, then click Next.

Table 15

Settings for the Configure Cisco Unity SIP Settings Page

Field

Setting

Contact Line Name

(Cisco Unity without failover) <the voice messaging line name that subscribers
use to contact Cisco Unity and that Cisco Unity will use to register with the
PIMG units>

(Cisco Unity with failover configured) <the name the primary Cisco Unity
server; this setting must match the Port X Endpoint parameter settings in the
PIMG administration; this setting must be the same for both the primary and
the secondary Cisco Unity servers>

Cisco Unity SIP Port

<the IP port on Cisco Unity that callers and the SIP server use to connect to
voice mail; we recommend using the default setting>

Preferred Codec

<the codec Cisco Unity will first attempt to use on outgoing calls>

r Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0

0L-12369-03 |



| Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0

Step 13

Step 14

Step 15

Step 16
Step 17

Creating a New Integration with the Ericsson MD-110 Phone System I

If other integrations already exist, the Enter Trunk Access Code page appears. Enter the extra digits that
Cisco Unity must use to transfer calls through the gateway to extensions on the other phone systems with
which it is integrated. Then click Next.

(Cisco Unity 4.2 and later only) On the Reassign Subscribers page, any subscribers whose phone system

integration has been deleted and who are not currently assigned to a phone system integration will appear
in the list.

If no subscribers appear in the list, click Next and continue to Step 15.

Otherwise, select the subscribers that you want to assign to this phone system integration and click Next.
You can use the following selection controls for selecting subscribers.

Table 16 Selection Controls for the Reassign Subscribers Page

Selection Control Effect

Check All Checks the check boxes for all subscribers in the list.

Uncheck All Unchecks the check boxes for all subscribers in the list.

Toggle Selected For the subscribers highlighted in the list, toggles between checking and

unchecking the check boxes.

If some highlighted subscriber check boxes are checked and others are
unchecked, clicking this button will check all the check boxes. Clicking again
will uncheck all the check boxes.

(Cisco Unity 4.2 and later only) On the Reassign Call Handlers page, any call handlers whose phone
system integration has been deleted and that are not currently assigned to a phone system integration will
appear in the list.

If no call handlers appear in the list, click Next and continue to Step 16.

Otherwise, select the call handlers that you want to assign to this phone system integration and click
Next. You can use the following selection controls for selecting call handlers.

Table 17 Selection Controls for the Reassign Call Handlers Page

Selection Control Effect

Check All Checks the check boxes for all call handlers in the list.

Uncheck All Unchecks the check boxes for all call handlers in the list.

Toggle Selected For the call handlers highlighted in the list, toggles between checking and

unchecking the check boxes.

If some highlighted call handler check boxes are checked and others are
unchecked, clicking this button will check all the check boxes. Clicking again
will uncheck all the check boxes.

On the Completing page, verify the settings you entered, then click Finish.
At the prompt to restart the Cisco Unity services, click Yes. The Cisco Unity services restart.

Alternatively, you can restart the Cisco Unity services in UTIM on the Tools menu by clicking Restart
Cisco Unity.

[ oL-12369-03

Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0 ]



Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0 |

I Creating a New Integration with the Ericsson MD-110 Phone System

Step 1
Step 2
Step 3
Step 4
Step 5

To Enter the Voice Messaging Port Settings for the Integration

After the Cisco Unity services restart, on the View menu, click Refresh.

In the left pane of the UTIM window, expand the phone system integration that you are creating.
In the left pane, click the name of the first PIMG unit.

In the right pane, click the Ports tab.

Enter the settings shown in Table 18 for the voice messaging ports.

For best performance, use the first voice messaging ports for incoming calls and the last ports to dial out.
This helps minimize the possibility of a collision, in which an incoming call arrives on a port at the same
time that Cisco Unity takes the port off-hook to dial out.

A

Caution  In programming the phone system, do not send calls to voice messaging ports in Cisco Unity
that cannot answer calls (voice messaging ports that are not set to Answer Calls). For example,
if a voice messaging port is set only to Message Notification, do not send calls to it.

Table 18 Settings for the Voice Messaging Ports

Field Considerations

Extension Enter the extension for the port as assigned on the phone system.

Enabled Check this check box to enable the port. The port is enabled during normal operation.

Uncheck this check box to disable the port. When the port is disabled, calls to the port get a
ringing tone but are not answered. Typically, the port is disabled only by the installer during
testing.

Answer Calls

Check this check box to designate the port for answering calls. These calls can be incoming
calls from unidentified callers or from subscribers.

Message Notification

Check this check box to designate the port for notifying subscribers of messages. Assign
Message Notification to the least busy ports.

Dialout MWI

(not used by serial or SMDI

Check this check box to designate the port for turning MWIs on and off. Assign Dialout MWI
to the least busy ports.

integrations)
AMIS Delivery Check this check box to designate the port for making outbound AMIS calls to deliver voice
(available with the AMIS messages from Cisco Unity subscribers to users on another voice messaging system.

licensed feature only)

Cisco Unity supports the Audio Messaging Interchange Specification (AMIS) protocol,
which provides an analog mechanism for transferring voice messages between different
voice messaging systems.

This setting affects outbound AMIS calls only. All ports are used for incoming AMIS calls.

Because the transmission of outgoing AMIS messages may tie up voice ports for long
periods of time, you may want to adjust the schedule on the Network > AMIS > Schedule
page so that outgoing AMIS calls are placed during closed hours or at times when

Cisco Unity is not processing many calls.

TRAP Connection

Check this check box so that subscribers can use the phone as a recording and playback
device in Cisco Unity web applications and e-mail clients. Assign TRAP Connection to the
least busy ports.
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Step 6
Step 7
Step 8

Step 9

Step 10
Step 11
Step 12
Step 13

Step 14
Step 15
Step 16

A

Testing the Integration W

Click Save.

Click the SIP Info tab.

(Cisco Unity 4.2 and later) Uncheck the Register with SIP Server check box and click Save.
(Cisco Unity 4.0 and 4.1) Uncheck the Register with Proxy Server check box and click Save.
At the prompt to restart the Cisco Unity services, click No.

Repeat Step 3 through Step 9 for all remaining PIMG units.

In the left pane, click Properties for the phone system.

In the right pane, click the PIMG tab.

Under Set Messaging Waiting Indicators (MWI) Using This Method, confirm that the Out-of-Band - SIP
NOTIFY option is selected.

Click Save.
At the prompt to restart the Cisco Unity services, click Yes.

After the Cisco Unity services restart, exit UTIM.

Caution

Do not edit the phone configuration file (also known as the switch ini file) to customize this integration.
If you change the settings in this file, the integration may not function correctly.

Testing the Integration

Step 1

Step 2

Step 3

To test whether Cisco Unity and the phone system are integrated correctly, do the following procedures
in the order listed.

If any of the steps indicate a failure, refer to the following documentation as applicable:
e The installation guide for the phone system.

e Cisco Unity Troubleshooting Guide, available at
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_troubleshooting_guides_list.html.

e The setup information earlier in this guide.

To Set Up the Test Configuration

Set up two test extensions (Phone 1 and Phone 2) on the same phone system that Cisco Unity is
connected to.

Set Phone 1 to forward calls to the Cisco Unity pilot number when calls are not answered.

A

Caution  The phone system must forward calls to the Cisco Unity pilot number in no fewer than four
rings. Otherwise, the test may fail.

In the Cisco Unity Administrator, create a test subscriber to use for testing by doing the applicable
substeps below.
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Step 4
Step 5
Step 6
Step 7

Step 8

Step 9
Step 10
Step 11

Step 12
Step 13
Step 14
Step 15

If your message store is Microsoft Exchange, do the following:

a. In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Profile page.
b. Click the Add icon.

c. Select New Exchange Subscriber.

d. On the Add Subscriber page, enter the applicable information.

e. Click Add.

If your message store is IBM Lotus Domino, do the following:

a. In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Profile page.
b. Click the Add icon.

c. Click Notes.

d. In the Address Book list, confirm that the address book listed is the one that contains the user data
that you want to import.

If the address book that you want to use is not listed, go to the System > Configuration >
Subscriber Address Books page and add a different address book.

e. In the Find Domino Person By list, indicate whether to search by short name, first name, or last
name.

f. Enter the applicable short name or name. You also can enter * to display a list of all users, or enter
one or more characters followed by * to narrow your search.

g. Click Find.

h. On the list of matches, click the name of the user to import.
i. On the Add Subscriber page, enter the applicable information.
j. Click Add.

In the Extension field, enter the extension of Phone 1.

In the Active Schedule field, click All Hours - All Days.

Click the Save icon.

In the navigation bar, click Call Transfer to go to the Subscribers > Subscribers > Call Transfer page
for the test subscriber.

For more information on transfer settings, refer to the “Subscriber Template Call Transfer Settings”
section in the Cisco Unity Administrator Help.

Under Transfer Incoming Calls, click Yes, Ring Subscriber’s Extension, and confirm that the extension
number is for Phone 1.

Under Transfer Type, click Release to Switch.
Click the Save icon.

In the navigation bar, click Messages to go to the Subscribers > Subscribers > Messages page for the test
subscriber.

Under Message Waiting Indicators (MWIs), check Use MWI for Message Notification.
In the Extension field, enter x.

Click the Save icon.

Open the Status Monitor by doing one of the following:

e In Internet Explorer, go to http://<Cisco Unity server name>/web/sm.
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e Double-click the desktop shortcut to the Status Monitor.

¢ In the status bar next to the clock, right-click the Cisco Unity tray icon and click Status Monitor.

To Test an External Call with Release Transfer

Step 1 From Phone 2, enter the access code necessary to get an outside line, then enter the number outside
callers use to dial directly to Cisco Unity.

Step2  On the Status Monitor, note which port handles this call.

Step3  When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting
means that the port is configured correctly.

Step4  Confirm that Phone 1 rings and that you hear a ringback tone on Phone 2. Hearing a ringback tone means
that Cisco Unity correctly released the call and transferred it to Phone 1.

Step5 Leaving Phone 1 unanswered, confirm that the state of the port handling the call changes to “Idle.” This
state means that release transfer is successful.

Step6  Confirm that, after the number of rings that the phone system is set to wait, the call is forwarded to
Cisco Unity and that you hear the greeting for the test subscriber. Hearing the greeting means that the
phone system forwarded the unanswered call and the call-forward information to Cisco Unity, which
correctly interpreted the information.

Step 7 On the Status Monitor, note which port handles this call.

Step8  Leave a message for the test subscriber and hang up Phone 2.

Step9  On the Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This state
means that the port was successfully released when the call ended.

Step10  Confirm that the MWI on Phone 1 is activated. The activated MWI means that the phone system and
Cisco Unity are successfully integrated for turning on MWIs.

To Test Listening to Messages

Step1  From Phone 1, enter the internal pilot number for Cisco Unity.

Step2  When asked for your password, enter the default password. Hearing the request for your password means
that the phone system sent the necessary call information to Cisco Unity, which correctly interpreted the
information.

Step3  Confirm that you hear the recorded voice name for the test subscriber (if you did not record a voice name
for the test subscriber, you will hear the extension number for Phone 1). Hearing the voice name means
that Cisco Unity correctly identified the subscriber by the extension.

Stepd  When asked whether you want to listen to your message, press 1.

Step5  After listening to the message, press 3 to delete the message.

Step6  Confirm that the MWI on Phone 1 is deactivated. The deactivated MWI means that the phone system and
Cisco Unity are successfully integrated for turning off MWIs.

Step7  Hang up Phone 1.
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Step 8

Step 1

Step 2
Step 3
Step 4

Step 1

Step 2
Step 3

Step 4

Step 5

Step 6

Step 7
Step 8

Step 1

Step 2
Step 3

On the Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This state
means that the port was successfully released when the call ended.

To Set Up Supervised Transfer on Cisco Unity

In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Call Transfer page.

If the name of the test subscriber is not displayed, click the Find icon (the magnifying glass) in the title
bar, then click Find, and select the name of the test subscriber in the list that appears.

For more information on transfer settings, refer to the “Subscriber Template Call Transfer Settings”
section in the Cisco Unity Administrator Help.

Under Transfer Type, click Supervise Transfer.
Set the Rings to Wait For field to 3.

Click the Save icon.

To Test Supervised Transfer

From Phone 2, enter the access code necessary to get an outside line, then enter the number outside
callers use to dial directly to Cisco Unity.

On the Status Monitor, note which port handles this call.

When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting
means that the port is configured correctly.

Confirm that Phone 1 rings and that you do not hear a ringback tone on Phone 2. Instead, you should
hear the indication your phone system uses to mean that the call is on hold (for example, music or beeps).

Leaving Phone 1 unanswered, confirm that the state of the port handling the call remains “Busy.” This
state and hearing an indication that you are on hold mean that Cisco Unity is supervising the transfer.

Confirm that, after three rings, you hear the greeting for the test subscriber. Hearing the greeting means
that Cisco Unity successfully recalled the supervised-transfer call.

During the greeting, hang up Phone 2.

On the Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This state
means that the port was successfully released when the call ended.

To Delete the Test Subscriber

In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Profile page.

If the name of the test subscriber is not displayed, click the Find icon (the magnifying glass) in the title
bar, then click Find, and select the name of the test subscriber in the list that appears.

In the title bar, click the Delete Subscriber icon (the X).
Click Delete.
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Integrating a Secondary Server for Cisco Unity Failover

Requirements

For Cisco Unity 4.1 and later, the Cisco Unity failover feature enables a secondary server to provide
voice messaging services when the primary server becomes inactive. For information on installing a
secondary server for failover, refer to the applicable Cisco Unity installation guide, available at
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html.

The Cisco Unity failover feature is not available when this phone system is integrated with
Cisco Unity 4.0 through PIMG units.

For information on failover, refer to the Cisco Unity Failover Configuration and Administration Guide.
The Domino version of the guide is available at
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/products_feature_guide_book09186a00803f
70f3.html. The Exchange version of the guide is available at
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/products_feature_guide_book09186a00801
b9241.html.

The following components are required to integrate a secondary server:

¢ One secondary server for each primary server installed and ready for the integration, as described in
the applicable Cisco Unity installation guide and earlier in this integration guide.

e A license that enables failover.

Integration Description

The Ericsson MD-110 phone system sends call information and MWI requests through the data link,
which consists of an RS-232 serial cable between the phone system and the master PIMG unit. Voice
connections are sent through the analog lines between the phone system and the PIMG units. The PIMG
units communicate with the primary and secondary servers through the LAN or WAN by using Session
Initiation Protocol (SIP). Figure 2 shows the required connections.
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Figure 2 Connections Between the Phone System and the Cisco Unity Servers
Additional
====Z==Z= =3 slave PIMG units
W ded
i as neede
‘:': a—
(R =y =l primary
‘;,\ i r:zz{zz{zz—'_ Cisco Unity server
o, Slave PIMG unit =
H:| W (calls only)

A—
Sl Secondary
Master PIMG unit Mol Cisco Unity server

Phone (SMDI data and calls)

LAN/WAN

———— Analog lines
ffffffff RS-232 serial cable
Network connections

153569

The primary and secondary servers act in the following manner:
e When the primary server is operating normally, the secondary server is inactive.
e When the primary server becomes inactive, the secondary server becomes active.

e When the primary server becomes active again, the secondary server becomes inactive.

Setting Up the Secondary Server for Failover

Do the following procedure to integrate the secondary server.

To Set Up the Secondary Server for Failover

Step1  Install a secondary server with the same configuration as the primary server. For installation instructions,
refer to the applicable Cisco Unity installation guide.

Step2  On the Windows Start menu of the secondary server, click Programs > Cisco Unity > Manage
Integrations. The UTIM window appears.

Step3  On the Integration menu of the UTIM window, click New. The Telephony Integration Setup Wizard
appears.

Step4d  Enter the settings to match the integration settings on the primary server.

~

Note = We recommend not reassigning any unassigned subscribers and call handlers to the new
integration, if you are asked by the wizard. Failover replication will automatically assign the
correct integration.

Step5 At the prompt to restart the Cisco Unity services, click Yes.

~

Note  When restarting the Cisco Unity services, use the UTIM prompt instead of the Cisco Unity icon
in the Windows taskbar. The taskbar icon does not restart all of the Cisco Unity services.

Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0
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Step6  After Cisco Unity restarts, on the Windows Start menu of the Cisco Unity server, click Programs >

Cisco Unity > Manage Integrations. UTIM appears.

Step7  In the left pane of the UTIM window, click the phone system integration that you created in Step 3.
Step8  For Cisco Unity 4.0 and 4.1, continue to Step 9.

For Cisco Unity 4.2 and later, do the following substeps.

a. In the right pane, click Properties.

b. On the Integration tab, compare the setting of the Integration ID field for the secondary server to the

setting of the Integration ID field for the primary server.

c. If the integration IDs of the phone system on the primary and secondary server are the same,

continue to Step 9.
If the integration IDs of the phone system on the primary and secondary servers are different, on the
secondary server, click Modify Integration ID.

d. When cautioned that subscribers associated with the current Integration ID setting will not be

automatically associated with the new Integration ID setting, click OK.

e. Inthe Modify Integration ID dialog box, in the Enter New Integration ID field, enter the Integration

ID setting for the phone system on the primary server and click OK.
f. Click Save.
g. At the prompt to restart the Cisco Unity services, click Yes.
h. In the left pane, click the phone system integration that you created in Step 3.
Step9  In the right pane, click the Ports tab.
Step10  Enter the port settings to match the port settings on the primary server.

Caution  In programming the phone system, do not send calls to voice messaging ports in Cisco Unity
that cannot answer calls (voice messaging ports that are not set to Answer Calls). For example,
if a voice messaging port is set only to Message Notification, do not send calls to it.

Step11  Click Save.
Step12 Repeat Step 9 through Step 11 for each remaining PIMG unit in the phone system integration.
Step13  Exit UTIM.
Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0
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Note

Step 1
Step 2

Step 3

Step 4

Step 5
Step 6
Step 7
Step 8
Step 9

Appendix: PIMG Integrations Over a WAN That
Use the G.729a Codec May Need to Disable
Comfort Noise

This appendix applies only to systems that use PIMG units with PIMG firmware release 4, SU6 or
earlier.

When the PIMG units connect to a WAN, use the G.729a codec, and have firmware release 4 SU6 or
earlier, you must disable comfort noise. Otherwise, callers will hear loud comfort noise after pressing a
DTMEF key or between prompts when recording a message.

To Disable Comfort Noise

On the Cisco Unity server, on the Start menu, click Run.

In the Run dialog box, enter regedit and click OK.

A

Caution  Changing the wrong registry key or entering an incorrect value can cause the server to
malfunction. Before you edit the registry, confirm that you know how to restore it if a problem
occurs. (Refer to the “Restoring” topics in Registry Editor Help.) Note that for a Cisco Unity
failover system, registry changes on one Cisco Unity server must be made manually on the
other Cisco Unity server, because registry changes are not replicated. If you have any
questions about changing registry key settings, contact Cisco TAC.

If you do not have a current backup of the registry, save the registry settings to a file by doing the
following depending on the Windows version:

Windows 2003 Click File > Export.
Windows 2000 Click Registry > Export Registry File.

Expand the registry key
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\Avaudio\Parameters
and double-click the ComfortNoise value in the right pane.

In the Edit DWORD Value dialog box, under Base, click Decimal.
In the Value Date field, enter 128.

Click OK.

Exit the Registry Editor.

Restart the Cisco Unity server.

Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0
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Step 10

Conventions W

If you are using failover, repeat this procedure to apply the registry setting to the secondary Cisco Unity

SErver.

Appendix: Documentation and Technical
Assistance

Conventions

The Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0 uses the following

conventions.
Table 19 Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0 Conventions
Convention Description

boldfaced text

Boldfaced text is used for:
¢ Key and button names. (Example: Click OK.)

e Information that you enter. (Example: Enter Administrator in the User
Name box.)

<>

(angle brackets)

Angle brackets are used around parameters for which you supply a value.
(Example: In the Command Prompt window, enter ping <IP address>.)

(hyphen)

Hyphens separate keys that must be pressed simultaneously. (Example: Press
Ctrl-Alt-Delete.)

>

(right angle
bracket)

A right angle bracket is used to separate selections that you make:

e Onmenus. (Example: On the Windows Start menu, click Settings > Control
Panel > Phone and Modem Options.)

¢ In the navigation bar of the Cisco Unity Administrator. (Example: Go to the
System > Configuration > Settings page.)

[x]

(square brackets)

Square brackets enclose an optional element (keyword or argument). (Example:
[reg-e164])

[x1y] Square brackets enclosing keywords or arguments separated by a vertical line
(vertical line) indicate an optional choice. (Example: [transport tcp | transport udp])

{x1y} Braces enclosing keywords or arguments separated by a vertical line indicate a
(braces) required choice. (Example: {tcp | udp})

The Ericsson MD-110 Serial PIMG Integration Guide for Cisco Unity 4.0 also uses the following

conventions:

[ oL-12369-03
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~

Note

A

Obtaining Documentation, Obtaining Support, and Security Guidelines

Means reader take note. Notes contain helpful suggestions or references to material not covered in the
document.

Caution

Means reader be careful. In this situation, you might do something that could result in equipment
damage or loss of data.

For descriptions and URLs of Cisco Unity documentation on Cisco.com, see the About Cisco Unity
Documentation. The document is shipped with Cisco Unity and is available at
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/about/aboutdoc.htm.

Obtaining Documentation, Obtaining Support, and Security

Guidelines

For information on obtaining documentation, obtaining support, providing documentation feedback,
security guidelines, and also recommended aliases and general Cisco documents, see the monthly
What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical
documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
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